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Installation and Setup Guide
System Requirements

Requirements for HourzPro, ExpenzPro and Reportz:
• Any version of the Palm Operating System and hardware with more than 128K of RAM
• ExpenzPro requires HourzPro and Reportz version 2.3 or greater. It will not run if an earlier

version of HourzPro or Reportz is installed.
• If you plan to use HourzPro/Reportz with QuickBooks Pro, you must have QuickBooks Pro

for Windows 5.0 or later.
• If you plan to use ExpenzPro/Reportz with QuickBooks, you must have QuickBooks for

Windows 5.0 or later.

ZoskSync requirements:
•  HotSync Manager version 1.1, 2.0 or later. ZoskSync is not compatible with HotSync Manager

version 1.2.
• Windows 95 or Windows NT 3.51 or later.

* Note: The ZoskSync is not compatible with Windows 3.1.

ZoskSetup.exe program requirements:
• Windows 95 or Windows NT 3.51 or later.
• Pilot Desktop and the HotSync Manager installed and properly configured

* Note: ZoskSetup.exe is not compatible with Windows 3.1.

Compatibility with Prior Versions of HourzPro
The 2.3 release can be safely installed over any earlier 2.x release. HourzPro and Reportz will
convert your existing data and preferences to the latest format. Some preference settings may be
reset to default values.

HourzPro, ExpenzPro and Reportz share a common database of projects/clients. Because of this,
their versions must be the same. ExpenzPro will not run if an earlier version of HourzPro or
Reportz is installed on your PalmPilot.

Note: Once you have installed any of the 2.3 PalmPilot applications on your PalmPilot, you
must not reinstall an earlier version without first deleting all Zoskware applications and
databases. The reason is that earlier versions do not check the database version number and may
crash and corrupt your data if an older database is present.

HourzPro is not compatible with Hourz 1.x databases in any way. Users of Hourz 1.x should
complete their billing cycle with Hourz 1.x and then switch to HourzPro/Reportz.

HourPro and Hourz 1.x can reside on the same Pilot with no conflicts. Their databases are
completely separate.

Contents of the Downloaded Zip File
All Zoskware products are distributed as a .zip archive that you must extract with an unzip utility.
Note the last two characters of some files listed below may change based on the latest version
number.
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HourzPro file list:
HrzPro23.prc HourzPro PalmPilot application
Rprtz23.prc Reportz PalmPilot application
ZoskSetup.exe Setup program for ZoskSync
ZoskSync.dll ZoskSync conduit to be installed in Pilot directory
ZoskMan.pdf This manual and software license agreement
ReadMe.txt Release notes for this version
Zlists.iif Example import file

ExpenzPro file list:
ExpPro23.prc ExpenzPro PalmPilot application
Rprtz23.prc Reportz PalmPilot application
ZoskSetup.exe Setup program for ZoskSync
ZoskSync.dll ZoskSync conduit to be installed in Pilot directory
ZoskMan.pdf This manual and software license agreement
ReadMe.txt Release notes for this version
Zlists.iif Example import file

Zoskware ProPack file list:
HrzPro23.prc HourzPro PalmPilot application
ExpPro23.prc ExpenzPro PalmPilot application
Rprtz23.prc Reportz PalmPilot application
ZoskSetup.exe Setup program for ZoskSync
ZoskSync.dll ZoskSync conduit to be installed in Pilot directory
ZoskMan.pdf This manual and software license agreement
ReadMe.txt Release notes for this version
Zlists.iif Example import file

Installing HourzPro, ExpenzPro and Reportz
Use Palm’s Instapp utility program to install the files HourzPro.prc and Reportz.prc. Instapp.exe is
located in your pilot directory. This installation assumes that you have PalmPilot Desktop installed
on your computer and the HotSync Manager is running.

Please Note:
Before installing the PalmPilot applications, you MUST disable any "hacks" and application
launchers that you have on your PalmPilot . Some hacks modify the behavior of the Palm
memory manager and will prevent the successful installation of large applications. If you get errors
when during HotSync installation of any Zoskware PalmPilot application and you appear to have
sufficient memory, the problem may be caused by hacks or application launchers. If you still have
problems, your PalmPilot memory may be fragmented. See the Troubleshooting Guide for more
details.

1) Disable all hacks and application launchers installed on your PalmPilot.

2) Use Palm’s Instapp.exe program to install all the .prc files included in your distribution:
HrzPro23.prc, ExpPro23.prc and Rprtz23.prc.

3) HotSync your PalmPilot.
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Installing ZoskSync
ZoskSync is a conduit that works with Palm’s HotSync Manager. ZoskSync has two functions:

• To transfer time and expense reports to your PC
• To transfer selection lists from text files on your PC to HourzPro, ExpenzPro and Reportz on

your Pilot. Selection lists can be exported from QuickBooks Pro or from an import file that
you create.

Follow these steps to install ZoskSync on your PC:

1) Exit the HotSync Manager

2) Run the ZoskSetup.exe program.

3) In the “Report Output Path:” field, enter the folder where you would like ZoskSync to save
HourzPro reports during HotSync. If left blank, ZoskSync stores reports in your ZoskSync user
directory (usually C:\Pilot\<user>\ZoskSync\). Click the browse button to choose a directory.

4) In the “Import File Path” field, enter the directory where you will store import list files (from
QuickBooks Pro or your own custom files) that are to be transferred to your PalmPilot during
HotSync. If left blank, ZoskSync searches your ZoskSync user folder for import files
(C:\Pilot\<user>\ZoskSync\). Click the browse button to choose a directory.

5) Select the preference for "Synchronize". Choose "All PalmPilot Records" to remove ALL list
items on your PalmPilot including ones that you create. Choose "Only Records Previously
Created by ZoskSync" to keep custom selections that you have entered on your PalmPilot.

6) Select the preference for handling records with the same name. Choose "Replace with Desktop
Version" if you always want the desktop version to placed on your PalmPilot. Choose "Retain
PalmPilot Changed Version" if you want to retain any changes you made to list items on your
PalmPilot.

7) Select the “Setup” button. ZoskSetup will check for the existence of the two paths you
specified, install the ZoskSync.dll conduit to your Pilot directory, and configure the Windows
Registry. If either path does not exist, ZoskSetup will prompt you to create it. If you choose not
to create the file, ZoskSync will not save reports or look for import paths.

8) Exit and restart the HotSync Manager.

9) HotSync your PalmPilot. Verify that ZoskSync runs by watching the HotSync Monitor dialog
window. You should see a message "Synchronizing ZoskSync". You can also check your
HotSync log  for ZoskSync messages. ZoskSync always reports the actions performed via status
messages in your HotSync log. If ZoskSync does not appear to be running, see the
Troubleshooting Guide.

Reconfiguring ZoskSync
You may change ZoskSync preferences by running ZoskSetup.exe at any time. Your new settings
will take affect after you restart the HotSync Manager.

Uninstalling ZoskSync
Uninstall simply removes ZoskSync configuration information from the Windows Registry. It does
not move or delete any files. Follow these steps to uninstall ZoskSync:

1) Run the ZoskSetup.exe program provided with this software.

2) Click the “Uninstall” button. A confirmation dialog notifies you of success or any problems.

3) Exit and restart the HotSync Manager.
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HourzPro User Guide
The HourzPro user guide provides instruction for the HourzPro PalmPilot application. For
instructions on creating and synching reports see the Reportz User Guide and the ZoskSync User
Guide.

Basic Concepts

Time Reporting with HourzPro
HourzPro and Reportz are part of a four step time reporting process that allows you to capture the
time you incur on your projects and transfer the information to your accounting system, invoices or
timecards.

Step 1: Capture Your Time
You use HourzPro as your time gathering tool. HourPro provides a flexible and powerful user
interface that is easily customized to your unique situation. The easiest way to capture your time is
to enter it into HourzPro as you work.

Step 2: Create a Report of Time Worked
When its time to transfer your accumulated time to your accounting system, you use Reportz to
generate a report of your HourzPro Time Entries. You select criteria, such as last month’s work on
ABC Project, and Reportz creates a text report in one of several formats. You select and customize
the format that best matches your accounting system and billing needs.

Step 3: HotSync Reports with ZoskSync
Once you have generated one or more reports, you simply HotSync your PalmPilot. ZoskSync
transfer the reports to your PC and stores them in a folder of your choosing.

Step 4: Import or View Your Data
The final step depends on your accounting system. You can simply open the file if your created a
tab or comma delimited report. Also, you can import your data into a custom database like
Microsoft Access or Claris’ FileMaker Pro.

If you use QuickBooks Pro, you can import the time report into you QuickBooks Pro company file.
Once your data is in QuickBooks Pro, you can easily assign the time and expenses to invoices, print
time reports, and transfer the time to payroll. See Guide to Working with QuickBooks Pro  for
complete details.

Time Entries
HourzPro allows you to track time by creating Time Entries. A Time Entry contains all the
information to describe a single period of work. The period of work can be several hours, a whole
day including breaks, or the work for an entire week.

Time Entries also allow you to track auto mileage.

Projects
Time Entries must be associated with a Project. You can create as many projects as you need
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limited only by available memory. The Project sets the initial billing rate for a Time Entry. The rate
for a Time Entry can also be customized in the Details View. Projects also capture the name of the
client company, the work order number, and several other fields.

To simplify the user interface and data entry, HourzPro omits the concept of a separate “client”
record. However, HourzPro Projects provide a field for the client name for billing purposes.

HourzPro and ExpenzPro share the same project list. If you add, edit or delete projects from
HourzPro, these changes will apply to ExpenzPro.

Tasks
Time Entries can optionally be associated with a Task. You can specify the task manually or choose
from a list of existing Task  Records. You can create as many tasks records as you like limited only
be available memory.

If you have imported QuickBooks Pro data, the Tasks list contains the Service Items from your
QuickBooks Pro company file. A Service Item associates a Time Period with a particular type of
work in your QuickBooks Pro company file.

Time Worked
HourzPro provides several ways to specify the time that you work.

• Enter the start and end times. The gross hours are automatically updated to reflect the new
time.

• Use the timer to accumulate more time. When a timer is stopped, the elapsed time is added to
the gross hours.

• Manually enter your time in the gross hours field.
• You can also specify the total break time during your work period which HourzPro

automatically subtracts from the gross hours to compute the total.

Reported Time Entries
Time Entries can be marked as “reported”. A reported Time Entry has been moved to the next stage
of your time reporting process. This may mean that you included the time on a time card, included
the time on an invoice, or created a report using Reportz – the HourzPro reporting application.

The reported status of a Time Entry is visible in the Time Entry Details dialog and can optionally be
displayed in Project View as a checkbox in the left most column.
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Working with List Views
HourzPro provides two customizable list views: Project View and Day View. Each view has
unique features and options that are targeted for a particular usage scenario. You can quickly
switch between Project and Day view by tapping the view selection buttons at the bottom of the
screen. From either list view you can:

• Create a new Time Entry
• Change display options
• Go to Reportz – the HourzPro companion application
• Go to ExpenzPro - the expense tracking companion application
• Select the quantity to be displayed in the right column and the totals field (total dollars, net

hours, expenses, or mileage).
• Filter the records displayed (by date or by project for Day/Project View respectively)
• Display time entries in expanded or compact format
• Hide or show a checkbox that indicates the "Reported" status of each entry.
• Choose an "Easy Entry" mode. Easy Entry makes creating new time entries a snap. See Using

Easy Entry for more details.

Project View
Project View displays all the Time Entries for a selected project or all projects. Its purpose is
twofold:

• Filter your time entries by project/client
• Provide a multi-day view of time entries

Compact Project View is shown below:

HourzPro Compact Project View



Zoskware ProPack User Guide

page  12

Day View

HourzPro Day View

Day View displays all the Time Entries on a single day and is not filtered by project.

Day View is designed for entering your daily hours as you work them. For this reason, the start and
stop times are displayed in the left most column so you can easily see the order and duration of your
tasks that day.

The advantages of Day View are:

• Easily view the total hours worked for today or any other day.
• View the start / stop times for the day's time entries.

Compact and Expanded List View Modes
New in Version 2.3! Both Project and Day View provide and expanded and compact viewing
mode. Expanded format includes two lines per time entry to show more detail. Compact view is
good for viewing an overview of more time entries.

Expanded and Compact Views are shown below:

   

Expanded List View and Compact List View

Using Easy Entry
New in Version 2.3! Both Project and Day View provide the Easy Entry time capture mode.

With Easy Entry, you can create Time Entries with two taps from the list view. Easy Entry allows
you to create a new time entry without having to enter all the details. Use Easy Entry when you start
a task at the beginning of the day when you don’t have all the work details.

When you tap the "New" button to create a time entry, Easy Entry:
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• Displays a popup menu of projects or tasks. A preference in "List View Options" determines
weather the popup list is for projects or tasks.

• When you select an item from the popup, Easy Entry creates a new time entry with your
selection

• Fills in the start time
• Starts the timer

With Easy Entry, there is no need to open the Time Entry View to enter details.

Note: If you set the preference to popup the Task List, HourzPro may still decide to popup the
Project List if it can’t determine what project to use for the new Time Entry. This happens when
there are no Time Entries on that day. Normally, the project for the most recent Time Entry is used
for the new Time Entry.

Using Timers in List Views
When an entry’s timer is running, HourzPro displays the Active Timer Control in the right most
column for that entry. In Compact View Mode, an ellipses is displayed "…". Entries without
running timers are displayed normally based on the Totals Popup. In Expanded View Mode, you can
start or stop the timer for entries simply by tapping the rightmost column.

Note: If the total is set to “Mileage, you will not be able to start/stop timers from list view, and the
Active Timer Icon will not be displayed for entries with running timers.

Viewing Totals
Either list view allows you to select the quantity that is to be displayed in the totals field and in the
right most column. Simply tap the totals popup at the bottom of the screen and select a new
quantity.

Note: If the total is not set to “Hours” or “Total”, you will not be able to start/stop timers from list
view, and the Active Timer Icon will not be displayed for entries with running timers.
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Editing Time Entries
Entry View allows you to specify the details of a Time Entry. HourzPro displays Entry View when
you create a new Time Entry or when you tap on an existing entry in one of the list views.

HourzPro Entry View

In Entry View, you can:

• Change the date of the entry by tapping the date select trigger in the upper right of the screen.
• Change the project assigned to an entry. You can select "None" if you don't want the time entry

associated with any project.
• Optionally choose a Task from the Task List Popup, or manually enter a custom Task.
• Enter the start and/or stop times by tapping on the “Times:” selector.
• Start or stop the timer by tapping on the “On”/”Off” timer controls.
• Manually enter the gross hours in the “Hours:” field.
• Enter your break time in the “Break:” field.
• Enter a description of the work at the bottom of the screen.

When you change any field affecting the total money for the entry, HourzPro automatically updates
the display.

Changing the Project
When a Time Entry is created, its project is set to either the current project (viewed in Project
View) or to "None" if viewing all projects.

You can change the entry’s project using the “Project” popup menu. When you change an entry’s
project, the entry’s rate changes to that of the new project.

The rate for a Time Entry is optionally displayed next to the “Hours:” field.

If you have specified a custom rate (See Editing Entry Details later in this section), you can reapply
the project rate by reselecting the entry’s project from the “Project” popup menu.

Selecting a Task
You can optionally choose a task to describe the work performed. Tasks can be manually entered or
chosen from the Task List Popup Menu. You can customize the list of predefined tasks in the Task
List Popup Menu.

If you are using QuickBooks Pro, the Task List contains your QuickBooks Service Items. Service
Items are like billing codes. They are used to identify the type of work and the billing rate in
QuickBooks Pro.
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Entering Start and End Times
Tapping the “Times:” selector opens the Set Hours Dialog.

Set Hours Dialog

When you select start/end times, the gross hours displayed in the “Hours:” field are updated to
reflect the new time.

Caution: If you have time accumulated in the “Hours:” field from Timers, this time will be
replaced when you edit the start/end times.

HourzPro does not put any constraints on the start and stop times. You can choose a start time that
is later than the end time.

Note: To simply the user interface, HourzPro does not provide an “end date”.  Because of this, the
maximum time that can be specified from the Set Hours Dialog is 23 hours 55 minutes. However,
you can manually enter up to 99 hours 59 minutes in the “Hours:” field.

If the entry’s timer is running, you cannot modify the End Time because it is undefined. In this case,
the Set Hours Dialog hides the “End Time” field. You can change the start time while a timer is
running without affecting the total hours.

Special Feature!: If you start a task and forget to start a timer for it, do the following:

• Create a new entry
• Start the Timer
• Set the start time to the time you actually began work
• When the timer is stopped, the hours are set to the hours you actually worked.

You can clear the start and/or end time by tapping the “No Time” button. This sets the selected time
to an undefined state. The gross hours are set zero in this case.

Entering Time Duration Values
You can enter duration values in both the “Hours:” and “Break:” fields. These fields support
flexible data entry as follows:

• Clock Notation: “12:45”
• Decimal Notation: “12.75”. When you click out of the field, decimal values are converted to

clock notation.
• Support for commas or periods: “12,75” is the same as “12.75”
• Hours with no minutes: “12”. When you click out of the field, the field is converted to

“12:00”.

Using the Entry Timer
You can start or stop the timer for an entry by tapping the “On” or “Off” control buttons. The
timer’s current state is reflected by the highlighted button.
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When a timer is started, the End Time is cleared because it is not known. By starting and stopping
the timer you can easily track time over a work period where you take many breaks or frequently
switch tasks. The End Time reflects the last time you stopped work.

When a timer is stopped, the end time is set to the current time, and the accumulated time is added
to the gross hours of the entry.

Note: HourzPro does not track multiple start and stop times for a single Time Entry. If you need
this level of detail, you should created a new Time Entry for each work period.

Editing Entry Details
You can enter details for a Time Entry by tapping on the “Details…” button at the bottom of the
Entry View.

HourzPro Entry Details Dialog

Customizing an Entry’s Rate
The first item shown in the Details Dialog is the entry’s billing rate. Initially this is copied from the
entry’s project. If you wish to customize the rate, first check the “Custom” checkbox. Then, enter
the custom rate in the “Rate:” field.

To restore the rate of the project, simply uncheck the “Custom” checkbox.

Fixed Price Services
Enter an amount in the "Fixed Rate" field for items that are not based on time. This can include
fixed price services or minor expenses. For full featured expense tracking, use ExpenzPro.

Tracking Your Mileage
Enter the begin and end odometer setting for the entry. HourzPro will auto-fill the last odometer
setting for each new entry.

Other Details
• The “Location:” field can contain the place where you work or anything else you like to store.
• If the Time Entry has been included in a report generated by the Reportz companion

application, the “Reported” checkbox will be checked.
• If the entry is not billable or reimbursable, uncheck the "Billable" checkbox.
• The “Private” checkbox will hide the record when you specify “Hide Private Records” from the

security application.
• You can delete the Time Entry by tapping the “Delete…” button. A confirmation dialog will

make sure you want to delete the record.
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Editing Projects and Tasks

Editing the Project List
Note: When you modify the project list, your changes apply to both HourzPro and ExpenzPro
because they share the same project database.

There are two ways to open the “Edit Projects” dialog:

• From any List View or Entry View, select the “Edit Projects…” menu item from the “Settings”
menu.

• From Entry View, tap the “Projects” popup. Then select the “Edit Projects…” menu item in
the displayed popup.

Edit Projects Dialog

The Edit Projects dialog displays the list of available projects without filtering hidden projects.

Creating a New Project
The Edit Project dialog is displayed when you select either the “New” or “Edit” buttons. A new
project has a default rate of $0.

Edit Project Dialog

Enter the project name and client name. Enter the billing rate for the project.

Check the “Hide in Lists” checkbox if you no longer actively use the project but want to retain
billing information. HourzPro will hide the project in all popup lists.

The remaining  fields are for your own use. You can use them to store additional project
information.

Changing a Project’s Rate
When you select the “Edit” button from the Edit Projects Dialog, the selected project is displayed in
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the Edit Project dialog. You can modify any of the fields and click “OK” to save them.

If you change the “Rate:” field, the following choice dialog is presented:

Project Rate Changed Choice Dialog

If you select “Yes”, all Time Entries associated with the project will be assigned the new rate.

If you select “No”, the Time Entries associated with the project will not be updated and will appear
to have a custom rate. See Customizing the Rate in the previous section.

Deleting a Project
To delete a project, tap the “Delete” button.

Caution: Deleting a project is not undoable. When you delete a project, all HourzPro Time
Entries and ExpenzPro Expense Records associated with that project are assigned to the
"None" project.

Editing the Tasks List
The HourzPro Tasks List is similar to the Categories List of other common PalmPilot application
with the exception that HourzPro allows you define to as many tasks as you like limited only by
available memory.

There are two ways to open the “Edit Tasks” dialog:

• From any List View or Entry View, select the “Edit Tasks…” menu item from the “Settings”
menu.

• From Entry View, tap the “Projects” popup. Then select the “Edit Tasks…” menu item in the
displayed popup.

Edit Tasks Dialog

From this dialog you can create a new task, delete tasks, and rename existing tasks.
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Using Timers

Timer Basics
HourzPro supports a stopwatch work timer for each Time Entry. When an entry’s timer is running
(“On”), the end time is unknown and not editable, and time is accumulating. When you stop an
entry’s timer, the accumulated time is added to the gross hours and the end time is set the current
time. You can restart/stop an entry’s timer as often as you like.

Multiple or Single Timers
By default, HourzPro allows only one running timer at any given time. In this mode, when you start
a new timer, the currently running timer is stopped and its entry is updated with the new time. This
makes it very easy to switch from task to task with a single click.

To allow multiple simultaneous timers, check the “Allow Multiple Timers” checkbox in the
“Preferences” dialog. See Customizing Preferences for detailed information.

In multiple timer mode, HourzPro does not automatically stop the running timer when you start a
new timer.

To stop all running timers, select the “Stop All Timers…” menu item from the “Options” menu.
This is convenient at the end of the day.

Note: This is not normally necessary, since the default mode is one timer only.

Rounding Values and Rounding Modes
Timers capture time in whole minute increments. Before being added to the total hours, time
accumulated by a timer is first rounded based on the selected Rounding Mode and Rounding Value.
See Customizing Preferences for details on setting the rounding preferences.

For example, if you have selected a “Round Value:” setting of  5 and a Rounding Mode of
"Nearest", HourzPro will round the accumulated time to the nearest 5 minutes. In this case,
accumulated time of two minutes rounds to zero while and accumulated time of three minutes
rounds to five minutes.

Starting/Stopping Timers from List Views
Timers can be easily toggled from any expanded List View. See Using Timers in List Views earlier
in this document.

Starting/Stopping Timers from Entry View
Timers can be manually controlled from the Entry View. See Using the Entry Timer earlier in this
document.

Timer Auto-Start Using Easy Entry
When you a create a new Time Entry with Easy Entry, HourzPro automatically starts the timer for
that entry. Of course, other running timers will be stopped if you don’t allow multiple timers.
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Customizing Display Options
HourzPro allows you to customize many aspects of the display to suit your individual work habits.

Customizing List Views
HourzPro maintains a separate set of display options for both Project List View and Day List View.
This allows you to customize each for your favorite usage mode.

The "List View Options" dialog allows you to set preferences for both Project and Day List Views.
The selector at the top of the window indicates which set of preferences is currently displayed.

To open the “List View Options” dialog either:

• Tap the “Show…” button in any List View
• Select the “List View Options…” menu item from the “Settings” menu.

List View Options Dialog

Compact View (1 line)
Select this checkbox if you want to use Compact View Mode for the selected list view. Expanded
format allows two lines per Time Entry and the Active Timer Control can be viewed and controlled.

Show Reported Checkbox
When this checkbox is checked, the "reported" status of each entry is displayed in the left-most
column as a checkbox.  This mode provides easy viewing of the status of all time entries. You can
also quickly mark entries reported .

Show Reported Entries
When this checkbox is checked, reported entries are visible in list views. To hide reported entries,
uncheck this checkbox. This allows you to view only the Time Entries that have not been billed.

Easy Entry Popup
Easy Entry is a convenient way to create new Time Entries available. See Using Easy Entry for
more details.

Selections for Easy Entry behavior include:

• Project causes Easy Entry to popup the list of projects
• Task causes Easy Entry to popup the list of tasks. The project is set the project of the latest

entry on the current day. If Easy Entry cannot determine which project to use, it will popup the
project list rather than the task list.
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• None disables the Easy Entry feature.

Text Fields Displayed
Use the popup menus to choose the fields displayed in the text field for each entry in List View. If
you have selected  the "Compact View (1 line)" checkbox, only two field popup menus will be
available. Otherwise, four popup menus will be available.

Each popup menu provides the following selections:

• Project
• Client
• Task
• Memo
• None

The fields are displayed in the same positions as the popups. The top two popups control the first
line of text while the bottom two popups control the second line of text.

If "None" is selected for a popup, not text is displayed in that position.

If an entry's project is "None", nothing is drawn for the project.

Entry View
The Entry View can be customized to your work habits by hiding the items you don’t use. When an
item is hidden, the remaining controls in the view are condensed and the text description area is
expanded to provide more memo viewing  area.

For example, if you don’t use start/end times and you don’t want to see the total dollars displayed,
simply uncheck the “Show Times” and “Show Total” checkboxes.
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HourzPro Preferences
HourzPro provides several settings to customize time tracking for your situation. You can change
preferences by selecting the “Preferences…” menu item from the “Settings” menu.

HourzPro Preferences Dialog

Showing Client Names
The “Show Client Names" preference determines how project names are displayed in popup menus.
If this option is checked, the display format is:

For example, if you setup a project with a client name of  “Zoskware” and a project name of
“HourzPro", the two display options would be:

Zoskware:HourzPro

Zoskware

Show Hidden Projects
Projects that you no longer actively work on can be designated hidden. See Editing Projects and
Tasks for details on marking a project hidden.

To show hidden projects in popup lists, check the “Show Hidden Projects” checkbox. If you want
hidden projects to be filtered out, uncheck it.

Allow Multiple Timers
The “Allow Multiple Timers” checkbox sets the timer mode for HourzPro. See Using Timers for
more information.

Start Timer for New Day Entries
When this checkbox is checked, the timer for new entries created from Day View will automatically
be started.

Round Value and Round Mode
HourzPro rounds accumulated timer  time based on the these two preferences. The choices for
rounding mode are:

• Nearest - Round up or down to the nearest "Round Mode" minute interval
• Up - Round up to the nearest "Round Mode" interval
• Down - Round down to the nearest "Round Mode" interval
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Both accumulated time is rounded and start/end times are rounded . See Using Timers for more
information on timers.

Default Break
When an new entry is created, HourzPro can automatically insert a default break time into the entry.
This is convenient if you always take the same lunch break everyday. Enter the break in minutes that
you want automatically inserted. If you enter zero, no break will be inserted.

You can always customize the break by manually editing it.

Currency Display Preferences
Enter the symbol you use for currency. The popup list displays the list of all system currencies. You
must have a PalmOS 2.0 or greater to use the currency menu.



Zoskware ProPack User Guide

page  24

Common Usage Scenarios

One Project – Simple
If you work on a single project for a long period of time and don’t need to track the tasks you work
on, the following options may be useful:

• Uncheck the “Show Client Names” preference. This will provide more viewing area for your
task and text notes.

• Configure Text Fields Displayed not to show the "Project" . This will provide more viewing
area for your task and text notes.

• Set “Easy Entry Popup” to “None” if you don’t want to be bothered with the Easy Entry popup.

One Project – Track Tasks
If you work on a single project for a long period of time, the following options may be useful:

• Uncheck the “Show Client Names” preference. This will provide more viewing area for your
task and text notes.

• Configure Text Fields Displayed not to show the "Project" . This will provide more viewing
area for your task and text notes.

• Set “Easy Entry Popup” to “Task”. This will make it easy to track tasks for your single project.

Many Projects/Clients – Switch Once Per Day
If you work on several projects during the course of a week, but you typically only work on one of
those projects on any given day, consider using the following preferences:

• Configure the Text Fields Displayed popups to show the “Project” so you can easily see which
project is associated with each work task.

• Optionally check the “Show Client Names” preference to provide better context for the display.
• Set “Easy Entry Popup” to “Task”. This will make it easy to switch tasks for a single client. At

the beginning of each day, HourzPro will prompt you for the project the first time you create
an entry. After this, HourzPro will display the “Tasks” popup so you can easily switch tasks.

Many Projects/Clients - Switch Projects Frequently
If you work on several projects during the course of a day, consider using the following
preferences:

• Configure the Text Fields Displayed popups to show the “Project” so you can easily see which
project is associated with each work task.

• Optionally check the “Show Client Names” preference to provide more context for the display.
• Set “Easy Entry” to “Project”. This will make it easy to switch projects.
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ExpenzPro User Guide
The ExpenzPro user guide provides instruction for the ExpenzPro PalmPilot application. For
instructions on creating and synching reports see the Reportz User Guide and the ZoskSync User
Guide.

Basic Concepts

Expense Reporting with ExpenzPro
ExpenzPro and Reportz are part of a four step reporting process that allows you to capture the
expenses you incur on business trips or your projects and transfer the information to your
accounting system, invoices or company expense reports.

Step 1: Capture Your Expenses
You use ExpenzPro as your expense gathering tool. ExpenzPro provides a flexible and powerful
user interface that is easily customized to your unique situation. The easiest way to capture your
expenses is to enter them when they.

Step 2: Create a Report of Exenses
When its time to transfer your expenses to your accounting system or company expense report, you
use Reportz to generate a report of your ExpenzPro Time Entries. You select criteria, such as "the
business trip to Comdex" or "last month's expenses for ABC Corp, and Reportz creates a text report
in one of several formats. You select and customize the format that best matches your accounting
system or expense report format.

Step 3: HotSync Reports with ZoskSync
Once you have generated one or more reports, you simply HotSync your PalmPilot. ZoskSync
transfer the reports to your PC and stores them in a folder of your choosing.

Step 4: Import or View Your Data
The final step depends on your expense reporting system. You can simply open the file if your
created a tab or comma delimited report. Also, you can import your data into a custom database like
Microsoft Access or Claris’ FileMaker Pro or Excel.

If you use QuickBooks, you can import the expense report into you QuickBooks company file.
Once your data is in QuickBooks Pro, you can easily assign the expenses to projects and invoices.
See Guide to Working with QuickBooks Pro  for complete details.

Expense Entries
ExpenzPro allows you to track expenses by creating Expense Entries. An Expense Entry contains all
the information to describe a single expense incurred. The expense can be associated with a business
trip, a client or your personal finances.

Projects
Expense Entries can be associated with a Project. Projects are typically used if you are a client-
based professional where you invoice clients for your time and expenses. However, if your are an
employee tracking company business expenses, you may choose to use the project for informational
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purposes.

You can create as many projects as you need limited only by available memory.

To simplify the user interface and data entry, ExpenzPro omits the concept of a separate “client”
record. However, ExpenzPro Projects provide a field for the client name for billing purposes.

ExpenzPro shares the project database with HourzPro. So any changes made to the project list will
affect both application.

Selection Lists
ExpenzPro provides several selection lists that you can use to classify your expenses. The available
lists are:

• Type - A long list of predefined types is included which you can customize.
• Trips - Denotes the business trip
• Payee - Indicates who received your money.
• Account - The financial account from which the money came  (checking, cash, visa etc).

All the selections above are provided by a popup menu in the Expense Entry View. You can add and
delete selections limited only by available memory.

You can specify the payee manually or choose from a list of existing Payee  Records.

If you have imported QuickBooks data, the Payees, Accounts and Projects lists will contain
information from your QuickBooks company file.

Reported Expenses
Expense Entries can be marked as “reported”. A reported Expense Entry has been moved to the next
stage of your expense reporting process. This may mean that you included the expense on a
company expense report, included the expense on an invoice, or created a report using Reportz – the
ExpenzPro reporting application.

The reported status of an Expense Entry is visible in the Expense Entry Details dialog and can
optionally be displayed in List View as a checkbox in the left most column.
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Viewing Expenses in List View
List View displays your expenses in a variety of way depending on the display options you select.
From List View you can:

• Create a new Expense Entry
• Change display options
• Go to Reportz – the ExpenzPro companion application
• Go to HourzPro - the time tracking companion application
• Select from one of five Viewing Modes.
• Display expenses entries in expanded or compact format
• Hide or show a checkbox that indicates the "Reported" status of each entry.

Compact and Expanded List View
Expanded format includes two lines per expense entry to show more detail. Compact view is good
for viewing an overview of more expense entries.

Expanded and Compact Project Views are shown below:

ExpenzPro Expanded Project View and Compact Project View

Viewing Modes
To slice and dice the view of your expenses, ExpenzPro provides five viewing modes:

• Account View all expenses in a singe account or all your accounts
• Trip View expense for a specific business trip or all your business trips
• Date View expenses on a specific date. No filter is performed.
• Project View expenses for a specific project or all projects.
• Type View expenses of a certain type or all types.

ExpenzPro View by Date



Zoskware ProPack User Guide

page  28

Entering Expenses
Entry View allows you to specify the details of an Expense Entry. ExpenzPro displays Entry View
when you create a new Expense Entry or when you tap on an existing entry in list views.

ExpenzPro Entry View

In Entry View, you can:

• Change the date of the entry by tapping the date select trigger in the upper right of the screen.
• Enter the amount of the expense. Negative values are allowed (deposits or credits)
• Optionally select a custom currency
• Enter a short description of the expense
• Specify the expense type
• Assign the expense to a specific business  trip
• Choose the account from which the money is paid
• Select the project/client to invoice for the expense
• Indicate if the expense has a receipt, is billable, is reported or private.

Changing the Project
When an Expense Entry is created, its project is set to either the current project if  the view mode is
"Project" (viewed in List View) or to "None" if viewing all projects.

You can change the entry’s project using the “Project” popup menu.

Default Selections
ExpenzPro assigns the default account and currency to each expense created. The only exception is
when the view mode is "Account". Then the currently selected account is assigned to new entries.
this level of detail, you should created a new Time Entry for each work period.

Entering Notes
Tap the "Notes" button to open a full size text note. You can enter up to 1024 characters into the
note.

Adding Attendees
If the expense is a meal or meeting, you can add attendees to the Note. Use the "Lookup Attendee"
menu item to add names from your PalmPilot address book.
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Customizing  Selection Lists

Editing the Project List
Note: When you modify the project list, your changes apply to both ExpenzPro and ExpenzPro
because they share the same project database. ExpenzPro does not allow you  to modify a project's
"rate", "work order" or "other" fields. You must enter  these from within HourzPro.

There are two ways to open the “Edit Projects” dialog:

• From any List View or Entry View, select the “Edit Projects…” menu item from the “Settings”
menu.

• From Entry View, tap the “Projects” popup. Then select the “Edit Projects…” menu item in
the displayed popup.

Edit Projects Dialog

The Edit Projects dialog displays the list of available projects without filtering hidden projects.

Creating a New Project
The Edit Project dialog is displayed when you select either the “New” or “Edit” buttons.  Enter the
project name and client name.

Check the “Hide in Lists” checkbox if you no longer actively use the project but want to retain
billing information. ExpenzPro will hide the project in all popup lists.

Deleting a Project
To delete a project, tap the “Delete” button.

Caution: Deleting a project is not undoable. When you delete a project, all HourzPro Time
Entries and ExpenzPro Expense Records associated with that project are assigned to the
"None" project.

Editing the Selection Lists
The ExpenzPro selection lists include: Types, Trips, Accounts and Payees. The Selection Lists are
similar to the Categories List of other common PalmPilot application with the exception that
ExpenzPro allows you define to as many items as you like limited only by available memory.
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Customizing Display Options
ExpenzPro allows you to customize many aspects of the display to suit your individual work habits.

Customizing List Views
To open the “List View Options” dialog either:

• Tap the “Show…” button in List View
• Select the “List View Options…” menu item from the “Settings” menu.

ExpenzPro List View Options Dialog

Compact View (1 line)
Select this checkbox if you want to use Compact View Mode for list view. Expanded format allows
two lines per Time Entry.

Show Reported Checkbox
When this checkbox is checked, the "reported" status of each entry is displayed in the left-most
column as a checkbox.  This mode provides easy viewing of the status of all entries. You can also
quickly mark entries reported .

Show Reported Entries
When this checkbox is checked, reported entries are visible in list views. To hide reported entries,
uncheck this checkbox. This allows you to view only the Expense Entries that have not been billed.

View Mode Popup
This popup serves the same function as the View By popup in the List View.

Text Fields Displayed
Use the popup menus to choose the fields displayed in the text field for each entry in List View. If
you have selected  the "Compact View (1 line)" checkbox, only two field popup menus will be
available. Otherwise, four popup menus will be available.

Each popup menu provides the following selections:
• Type
• Detail
• Payee
• Project
• Client
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• Account
• Trip
• Notes
• None

The fields selected are displayed in the same positions as the popups. The top two popups control
the first line of text while the bottom two popups control the second line of text.

If "None" is selected for a popup, not text is displayed in that position.

If an entry's project is "None", nothing is drawn for the project.
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ExpenzPro Preferences
ExpenzPro provides several settings to customize expense tracking for your situation. You can
change preferences by selecting the “Preferences…” menu item from the “Settings” menu.

ExpenzPro Preferences Dialog

Showing Client Names
The “Show Client Names" preference determines how project names are displayed in popup menus.
If this option is checked, the display format is:

For example, if you setup a project with a client name of  “Zoskware” and a project name of
“ExpenzPro", the two display options would be:

Zoskware:ExpenzPro

Zoskware

Show Hidden Projects
Projects that you no longer actively work on can be designated hidden. To show hidden projects in
popup lists, check the “Show Hidden Projects” checkbox. If you want hidden projects to be filtered
out, uncheck it.

Currency
Select the default currency for new entries. You must have PalmOS 2.0 or later to use custom
currencies.

Account
Select the default account applied to new entries. This setting is ignored if the view mode is
"Account". In that case, the currently selected account is assigned to the new expense.
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Reportz User Guide
Reportz Basics

Reportz is a companion application to HourzPro and ExpenzPro that allows you to collect and
report the time captured with HourzPro and the expenses captured with ExpenzPro.

Report List View
Reportz maintains a list of the reports it has generated. The Report List View displays the
following:

• The "synched status" icon. A bullet is displayed for reports not transferred to your desktop
computer. A checkmark is displayed for reports that have already been synched.

• The "report type" icon. A small clock is used for HourzPro reports and a dollar sign is used for
ExpenzPro reports.

• The date the report was created
• The title of the report
• The total money for the expense entries included in the report.

Reportz List View

You create a new report by either tapping the “Time Report” button or the "Expense Report"
button. See Creating Reports for an extensive guide on creating reports.

You can change format options using the Settings menu items. You also have an opportunity to
change format options whenever you create a report.

You can quickly go to HourzPro or ExpenzPro by tapping the "stopwatch" button or "dollar sign"
button respectively.

Report Content View
Reportz does not permit editing of the report data once it is generated. However, you can view the
report content by tapping a report in the Report List View. The Report Content View is much like
the MemoPad except you cannot edit.

You can use the Copy menu item to copy the text to the clipboard if there is sufficient memory. The
report content can be pasted  to the MemoPad.
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Transferring a Report Again
Once a report is transferred  to your desktop computer by ZoskSync, it will be marked "synched"
and will not be transferred again. If you want to transfer the report again, you can clear the
"synched" status using the "Transfer on Next HotSync" menu item from the "Options" menu of the
Report Content View.

This menu item clears the synched attribute of the report so it will be transferred again.

Deleting Reports
Reports can be deleted individually from the Report Content View.

You can also delete all reports using the “Delete All Reports…” menu item from the “Options”
menu.

Normally, you don’t need to delete reports. ZoskSync takes care of this automatically when it
transfers reports to your desktop computer. However, if you have changed the default preferences,
ZoskSync may not delete your reports during HotSync.

Reportz Preferences

Delete Reports After HotSync
When the “Delete Reports After HotSync” checkbox is checked, ZoskSync deletes all reports after
they are transferred to your desktop computer.

If this checkbox is not checked, ZoskSync does not delete your reports. You may want to change
this setting if you want to see a long-term list of the reports you created.

With either of these settings, ZoskSync will not transfer a report twice.

Use System Time Format
Normally Reportz outputs time fields in HH:MM:SS format using a 24 hour clock. If you would
like to use the System Time format, select this checkbox. You can modify the System Time Format
using the "Prefs" application on your PalmPilot.

Save Reports to MemoPad
Macintosh users should set this preference. When this is checked, Reportz stores the report text as a
new memo in your MemoPad application. Since the Macintosh HotSync Manager does not support
3rd party  conduit's this feature allows you to transfer your data to your Macintosh..

Include Currency in Money Fields
Normally, for non-QuickBooks reports, Reportz includes a currency symbol in all money fields.
For HourzPro reports, the symbol is taken  from the HourzPro currency preference. For ExpenzPro
reports, the currency symbol assigned to the expense is used.

Uncheck this checkbox if you want to force no currency symbol in money fields. Users of
TimeSlips Deluxe should uncheck this checkbox as it does not support money fields with currency
symbols.
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Creating Reports

Step 1: Choose a Report Type: Time or Expense
You must first decide whether you want an expense or time report. Tap the appropriate button in
Report List View to create the report type you desire.

Step 2: Choose a Report Format
The first time you create a report, Reportz displays the Report Format Dialog. This allows you to
choose the format you need and customize its options. The Time Report Format Dialog is shown
below for both QuickBooks Pro format and Comma Separated Value format.

Time Report Format Dialog (QuickBooks Pro and Comma Separated Values)

To select a different report format, use the “Format:” popup menu to make your selection. The
available selections are described below.

QuickBooks Pro Format
Both HourPro and ExpenzPro can exchange information with QuickBooks Pro via Intuit
Interchange Format (IIF) files. When you select the QuickBooks Pro format, Reportz generates a
report data that complies with IIF.

See Guide to Working with QuickBooks Pro  for complete details on how to setup data exchange
with QuickBooks Pro.

Excel (CSV) Format
When you select Excel (CSV), Reportz uses commas ‘,’ to separate export fields. This is a common
format used by many spreadsheets and databases.

Excel (CSV) format allows you to customize the fields included in your report. See Customizing
Format Options for more details. Text fields are wrapped in double quotes.

Tab Separated Format
When you select Tab Separated format, Reportz uses tab characters to separate export fields. Like
Excel (CSV) Format, this format allows you to customize the fields included in your report.

Step 3: Specify Report Criteria
After you choose a format, you need to specify the criteria used to gather time or expense entries
from HourzPro or ExpenzPro.
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Below the two report criteria dialogs:

Create Time Report Dialog and Create Expense Report Dialog

The criteria provided are:

• Title: Enter a title for the report. ZoskSync appends an appropriate suffix to your report
file when its transferred to the PC (.iif, .csv, or .txt).

• Trip: (Expense reports only) Select expense entries from a specific business trip.
• Project: Select entries from “All Projects” or from one specific project.
• Period: Select the date range of entries to include. Several convenient options are provided

or you can specify a custom period.
• Status: Choose whether to include entries based on their reported status. Normally, you

should select “Unreported Only”.
• Action: After the report is created, Reportz can optionally perform an action on all entries

include in the report. Reported entries can be deleted or they can be marked
reported. If you don’t want either of these options, select “None”. Marking entries
reported is an easy way to track the entries that have been transferred to your PC.

Step 4: Create the Report
To create the report, simply tap the “Create” button.

If your report does not include any entries, Reportz will not create a report and will notify you with
an alert dialog.

Report size is limited to 32K. If your report includes so many entries that the maximum size is
exceeded, Reportz will save the partial report and inform you that all entries could not be included.
You can then create another report with the same criteria to capture the remaining entries (assuming
that you marked entries billed or deleted them).

Step 5: HotSync Your Reports to Your PC
Once you have created one or more reports, you can transfer them to your PC using ZoskSync.
Simply HotSync your PalmPilot and the ZoskSync conduit takes care of transferring your reports.

ZoskSync stores each report in a separate text file in the ZoskSync Reports Folder. The name of the
report file is based on the title of the report. ZoskSync appends an abbreviated date and a suffix
depending on the report format:

.IIF QuickBooks Pro Format

.CSV Excel (CSV) Format

.TXT Tab Separated Format

When you setup ZoskSync, you were asked to specify the “Report Output Folder”. This is where
your reports are stored.

For example: A QuickBooks Pro report might be transferred to a file named “Hourz-Report
9/27.iif”.
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Step 6: Import or View Your Reports
Once your reports are on your PC, you can do several things with them depending on the report
format.

QuickBooks Pro reports are ready to be imported into your QuickBooks company file. See Guide
to Working with QuickBooks Pro  for more information.

To open an Excel (CSV) report, simply double-click the file in Windows Explorer. Excel will be
launched, and will display your report.

You can import Tab Separated or Excel (CSV) reports into many off-the-shelf database applications
like Microsoft Access, FileMaker Pro, FoxPro etc.
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Customizing Format Options

Text Reports
Both Excel (CSV) and Tab Separated report format are referred to as “Text Reports”. Reportz
provides many customization options for Text Reports as illustrated below:

Time Report Text Format Setup Dialog

Since neither HourzPro or ExpenzPro track employee names, you can enter your employee name in
the “Employee:” field.

You can optionally include headings in your report. When this option is selected, Reports creates a
column heading in the first line of the report that includes the names of all fields included in your
report. This makes it easy to identify the data in each column.

Reportz gives you the ability to choose which fields should be included in a report and in what
order they are to be included. Use the “Fields:” list checkboxes to include or remove fields.
Checked fields are included and unchecked fields are not.

To change field order:

• Select the field to be moved
• Tap the “Up” or “Down” buttons to move the field to the desired position. This list is scrolled

as necessary.
To restore the default field order, tap the “Defaults” button at the bottom of the screen.

QuickBooks Pro Reports
QuickBooks Pro reports cannot be customized. However, you must enter required information
before a valid report can be generated. See Guide to Working with QuickBooks Pro   for more
complete details.
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Guide to Working with QuickBooks Pro

Overview

The Zoskware application suite (HourzPro, ExpenzPro and Reportz) serve as a time and expense
capture tool for QuickBooks Pro.

HourzPro functions much like the Timer application shipped with QuickBooks Pro. The difference
is that HourzPro runs on the PalmPilot and Timer runs on the PC. The following outline describes
how to use QuickBooks Pro with HourzPro:

1) If you are using QuickBooks Pro, you must first import QuickBooks Pro Lists from your
company file into HourzPro or ExpenzPro. You should do this before you create time or
expense entries on your. See Importing QuickBooks Pro Lists  below for details.

2) Once QuickBooks data has been imported, you capture your time with HourzPro and your
expenses with ExpenzPro just as you normally would. See Using Imported Data for details.

3) When its time to transfer your Time or Expense Entries to QuickBooks, you use Reportz to
generate a QuickBooks Pro report. See Choosing QuickBooks Pro Report Settings for details.

4) You then transfer your reports to your PC using HotSync and the ZoskSync conduit. ZoskSync
stores reports in the ”Report Output Path" folder you specified during ZoskSync setup.

5) The final step is to import your time or expense report into QuickBooks Pro. See Importing
Reports Into QuickBooks Pro.

Importing QuickBooks Pro Lists
To use HourzPro/ExpenzPro with QuickBooks Pro, you must first import QuickBooks
information to your PalmPilot. These instructions assume that you have already created a
QuickBooks Pro company file with appropriate. Refer to your QuickBooks Pro user guide for
information on setting up your company file.

For HourzPro, Import a Timer Export File
1) Open your QuickBooks Pro company file.

2) Select the “Export Lists for Timer…” menu item under the “Timer Activities” under the “File”
menu.

3) QuickBooks Pro displays the Timer Export dialog.

4) Select the “OK” button.

5) QuickBooks Pro asks you to save the export file.

6) Use the dialog to navigate to the folder you specified as the "Import File Path" (specified in
ZoskSetup.exe). If you forgot the directory, you can run ZoskSetup.exe to view or edit the path.

7) Save the file as “HrzLists.iif”.  You MUST name the timer export file “HrzLists.iif”. If you
don’t, ZoskSync won’t import your QuickBooks Pro timer reporting data to your PalmPilot.

8) HotSync your PalmPilot. ZoskSync transfers your QuickBooks Pro Company data to your
PalmPilot.

For ExpenzPro, Create a List Export File
Expense reports created with Reportz can be imported into both QuickBooks and QuickBooks Pro.
1) Open your QuickBooks company file.
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2) Select the “Export…” menu item under the “File” menu.

3) Select the checkboxes: "Chart of Accounts", "Customer List", "Vendor Lists".

4) Click OK. QuickBooks will prompt you to save the export file.

5) QuickBooks Pro asks you to save the export file.

6) Use the dialog to navigate to the folder you specified as the "Import File Path" (specified in
ZoskSetup.exe). If you forgot the directory, you can run ZoskSetup.exe to view or edit the path.

7) Save the file as “ExpLists.iif”.  You MUST name the export file “ExpLists.iif”. If you don’t,
ZoskSync won’t import your QuickBooks expense reporting data to your PalmPilot.

8) HotSync your PalmPilot. ZoskSync transfers your QuickBooks Company data to your
PalmPilot.

Verifying QuickBooks Pro Import
To verify that your QuickBooks Pro data was transferred, follow these steps on your PalmPilot:

1) Launch the “Reportz” app by tapping its icon on your PalmPilot.

2) Select the "Text Report Format…" menu item from the "Settings" menu (available in List
View).

3) Select the “QuickBooks Pro” from the “Format” popup menu at the top of the screen.

4) Reportz will inform you that you need to make some selections. This is normal.

5) If your company name is displayed and your company ID is not zero, your QuickBooks Pro
data has been successfully imported to your PalmPilot.

6) For time reports, you may now choose which employee you are from the “Employee:” popup
lists.

Using Imported Data

What Data is Imported?
ZoskSync transfers QuickBooks Pro data as a follows:

• QuickBooks Pro company file name and id are stored in Reportz preferences. This information
is needed later when you transfer reports into QuickBooks Pro.

• QuickBooks customer:job list is stored in the HourzPro/ExpenzPro shared project database.
The customer name is stored in the Project’s “Client Name” field, the job name is stored in the
Project’s “Name” field. If there is no job name, then the customer is stored in the Project’s
“Name” field.

• QuickBooks Inventory Items  of type "service item" are stored in the HourzPro Tasks List.
• QuickBooks Vendors are stored in the ExpenzPro payees database.
• QuickBooks Bank and Credit Card Accounts are stored in the ExpenzPro accounts database.
• QuickBooks Expense Ledgers are stored in the ExpenzPro types database.
• QuickBooks Employees and "Other Names" are stored in the Reportz employees database.

Assigning Service Items
QuickBooks Pro requires that you assign a Service Item to each Time Entry. You have two options
for assigning Service Items to time entries:

• Use HourzPro Tasks: The list of QuickBooks Pro Service Items are added to your HourzPro
Task List. You can assign unique Service Items to each Time Entry by selecting the desired
item from the Task List.
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• Choose One Service Item:  If you only use one Service Item or you want to use HourzPro
tasks for another purpose, you can choose to have Reportz use a single Service Item for all
Time Entries. See Choosing QuickBooks Pro Report Settings for more details.

Choosing QuickBooks Pro Report Settings (Time Reports Only)
Once you have successfully imported your QuickBooks Pro data, you must make the required
selections in the QuickBooks Pro Format dialog before creating time reports:

QuickBooks Pro Setup Dialog (for Time Reports)

Select an Employee
You must select an employee from the “Employee:” popup list. Reportz and QuickBooks require
this information. The list contains the employees defined in your QuickBooks Pro company file.

Optionally Select a Service Item
QuickBooks Pro requires that you assign a Service Item to each Time Activity. Normally, Reportz
uses the Task field from your HourzPro Time Entries as the QuickBooks Pro Service Item.
However, if you use the HourzPro task field for something else, you can override this behavior by
checking the “Override Task with Item” checkbox. You must then select an item from the list of
QuickBooks Pro Service Items. In this case, Reportz uses your selection as the Service Item for all
Time Entries in the report rather than the entry’s task.

Importing Reports into QuickBooks Pro
Once reports have been transferred to your PC, they are ready to be imported into QuickBooks Pro.
Follow these steps to import a report into QuickBooks pro:

Time Reports
1) Open your QuickBooks Pro company file.

2) Select the “Import Activities from Timer…” menu item from the “Timer Activities” submenu
item under the “File” menu.

3) Select the “OK” button.

4) Use the Windows Open File Dialog, navigate to your reports folder and select the report you
want to import.

5) If there are problems with the data, QuickBooks Pro asks you to correct them.

6) Once the data has been imported, QuickBooks Pro displays a confirmation dialog named
“QBPro Timer Import Summary” from which you can view details of all the imported time
records.
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Expense Reports
1) Open your QuickBooks Pro company file.

2) Select the “Import …” menu item from the “File” menu.

3) Use the Windows Open File Dialog to navigate to your "Report Output Path" folder and select
the report you want to import. Use ZoskSetup.exe to specify your "Report Output Path".

4) QuickBooks displays an import status dialog when complete.
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Guide to Working with BillQuick™

Overview
Users of BillQuick can import time and expense data from HourzPro and ExpenzPro into their
BillQuick datafile using the BillQuick PalmLink utility application. For complete instructions on
using BillQuick or BillQuick PalmLink, please see your BillQuick user guide.

Installing Import Templates and the PalmLink Application
Note: If the BillQuick PalmLink software and templates are not included with your Zoskware
distribution, you can download it from the Zoskware website at
http://www.zoskware.com/support.htm.

Included with your software distribution of HourzPro/ExpenzPro are two pre-made import
templates designed to work with the BillQuick PalmLink.exe application.

• Hourzpro.dfi BillQuick Import template for HourzPro CSV reports
• Expnzpro.dfi BillQuick Import template for ExpenzPro CSV reports
• PalmLink.exe Application that controls import/export to and from BillQuick

To install, copy the files listed above to the BillQuick folder on your local hard drive. By default,
BillQuick is installed in  C:\Program Files\BillQuick .

Special Instructions on Creating Reports for BillQuick
In order to successfully import HourzPro or ExpenzPro reports to BillQuick:

• Reports to be imported can be in either Excel (CSV) or Text (Tab) format.
• You must use the default field preferences. In Reportz, click the "Defaults" button on the

format dialog to restore default field preferences.

Importing HourzPro/ExpenzPro Reports into BillQuick
Use the PalmLink.exe application to import HourzPro or ExpenzPro reports as follows

• Create and HotSync your report to your desktop computer
• Launch the PalmLink.exe application located in your BillQuick folder.
• Choose an Employee ID
• Click the "Import" button.
• In the "From" box, select the report to be imported into BillQuick. For convenience, we

recommend that you configure ZoskSync to store  reports in the BillQuick folder.
• Click the "Read" button.
• Click the "Load DFI" button. If you are importing a time report (HourzPro), select the

"Hourzpro.dfi" template. If you are importing an expense report (ExpenzPro), select the
"Expenzpro.dfi" template.

• Enter your BillQuick file as the "Destination File" in the "To" box.
• Click the "Begin" button.

The PalmLink application maps the "Other" field (from HourzPro project records) to  the "Cost
Rate" field within BillQuick projects.

Exporting BillQuick Lists to HourzPro/ExpenzPro
Use the PalmLink.exe application to export lists of projects, activities, expense codes and
employees to HourzPro/ExpenzPro as follows:

• Launch the PalmLink.exe application located in your BillQuick folder.
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• Make sure the "From" field contains the correct BillQuick data file name.
• Set the "To" field to your ZoskSync Import Files Path. This path is set via the ZoskSetup.exe

program (as "Import Files From:").
• Select your Employee ID.
• By default, all activity codes, expense codes and active projects will be exported. You can

customize these settings.
• Click the "Begin" button.
• Upon successful export, the PalmLink application will create a file named "Zlists.txt" in the

folder specified in the "To" field.
• HotSync your PalmPilot to transfer the exported  lists to your PalmPilot.

For problems or questions regarding PalmLink, send e-mail to support@bqe.com or visit the
BQE Software Inc website at http://www.bqe.com.
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Guide to Working with Timeslips Deluxe

Overview
Users of TimeSlips Deluxe can import HourzPro and ExpenzPro time and expense data into their
Timeslips datafile using the TimeSlips TSImport utility program.

For complete instructions on using TimeSlips Deluxe or TSImport, please see your TimeSlips user
guide.

Downloading Timeslips Deluxe Support
The templates needed to transfer time and expenses to Timeslips Deluxe are not included with your
software distribution. If you plan to use Timeslips Deluxe with Zoskware products, you must first
download the Timeslips support files from the Zoskware website. Follow these steps to download
the support files:

• Point your web browser to the address: http://www.zoskware.com/binaries/tssupp.zip.
• Your browser will download the files. Click save if necessary to save the zip file to you hard

drive.
• Use WinZip or similar utility to decompress the file.

Installing TSImport Templates
Included in the downloaded file two pre-made import templates designed to work with TSImport

• Hourzpro.tpl TSImport template for HourzPro CSV reports
• Expnzpro.tpl TSImport template for ExpenzPro CSV reports

You can customize these templates using TSImport if they do not meet your needs.

To install these templates, copy them to the "imptmplt" subdirectory in your TimeSlips folder.

Special Instructions on Creating Reports for TimeSlips
In order to successfully import HourzPro or ExpenzPro reports to TimeSlips Deluxe:

• You must uncheck the Reportz preference "Include Currency in Money Fields". TSImport does
not handle currency symbols in money fields.

• Reports to be imported must be in Excel (CSV) format
• You must use the default field preferences. In Reportz, click the "Defaults" button on the

format dialog to restore default field preferences.
• The contents of the fields included in your report must match existing selections in your

TimeSlips Deluxe data file. For example, if you manually enter a project named "ABC Project"
that is not already in TimeSlips, and you create a time report against this project, you will not
be able to import this report.

Importing HourzPro/ExpenzPro Reports into TimeSlips
Use TSImport to import HourzPro or ExpenzPro reports as follows

• Create and HotSync your report to your desktop computer
• Open TSImport.exe
• Select the "Open" menu item from the "File" menu.
• Use the dialog to select an import template from the "imptmplt" directory in your TimeSlips

folder. If you are importing an HourzPro report, select the "Hourzpro.tpl" template. If you are
importing an ExpenzPro report, select the "ExpnzPro.tpl" template. TSImport will open your
import template.
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• Enter your HourzPro or ExpenzPro report as the "Source File".
• Enter your TimeSlips Deluxe file as the "Destination File".
• Click the "Import" button.
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Appendix A: Troubleshooting
Guide
General Issues

Restoring HourzPro/ExpenzPro Data After a Hard Reset
HotSync does not automatically restore your backed-up databases after your PalmPilot crashes or is
hard reset. You must configure the HotSync Manager’s System Conduit to do this using Pilot
Desktop.

1) Make a backup copy of your “Backups” folder. Your backups folder is located in
C:\pilot\<user name>\backups where <user name> is your HotSync name (or the Windows
munged name version of your HotSync name).

2) Open Pilot Desktop (Pilot.exe)

3) Select your PalmPilot user name from the popup menu.

4) Select the “Custom…” menu item from the “HotSync” menu.

5) Select the “System Conduit” and click the “Change…” button.

6) Select the “Desktop Overwrites Pilot” radio button and click the “OK” button.

7) HotSync your PalmPilot.

Your HourzPro, ExpenzPro and Reportz databases will be restored after you HotSync. Make sure
you have the latest version of the HotSync Manager. Earlier versions had bugs that would prevent
your data from being backed-up.

Compatibility with Previous Versions
It is safe to install HourzPro, ExpenzPro and Reportz over previous versions of HourzPro. Your
existing data is converted to the latest formats. Some preference options may be reset to the default
value.

Error installing your PalmPilot applications
If HotSync reports problems while trying to install HourzPro, ExpenzPro or Reportz, you may need
to remove programs to free memory.

Certain programs, like HackMaster, AlarmHack, Launcher and others may interfere with the
installation. They actually make your PalmPilot appear full when there is free memory. You must
disable or remove these programs and reset your PalmPilot before installing HourzPro. Then,
reinstall them afterwards.

If you still have problems installing, your PalmPilot memory may be fragmented. You should
defragment it with a third party tool called Defragger from TRG.

Troubleshooting HourzPro
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Why are My Running Timers Not Displayed in List Views?
Check to make sure you don't have the totals popup set to display “mileage”. In this mode, the timer
controls are not displayed.

Tracking Break Start and Stop Times
HourzPro Time Entries track a single start and stop time. If you need to track start and stop times
for each segment of work time, you should create individual Time Entries for each time period.

Why Is the Rate of My QuickBooks Pro Projects Always $0?
QuickBooks Pro does not export the project rate information. You can manually enter the rate for a
QuickBooks Pro project, but it will not affect any billing rates in your QuickBooks Pro company
file.

Troubleshooting ZoskSync

ZoskSync Doesn't Seem to Run During HotSync
This is a common problem. Common pitfalls include:

• Make sure you have properly installed the ZoskSync conduit by running the ZoskSetup.exe
program included with the software.

• You MUST first exit the HotSync Manager, then install ZoskSync and restart the HotSync
Manager.

• You MUST use HotSync Manager version 1.1 or 2.0 or later. ZoskSync is not compatible with
Franklin's HotSync Manager version 1.2.

• Make sure you restarted the HotSync Manager after you installed ZoskSync. If you are a
Windows NT user, you may need to logout and log back in.

• Earlier versions of some 3rd party HotSync software improperly setup the Windows Registry.
Make sure you have the latest version or temporarily remove these conduits and try ZoskSync
again.

ZoskSync Doesn't Import Lists to My PalmPilot
• Make sure ZoskSync is running during HotSync. To do this, open your HotSync log and look

for ZoskSync status messages. If there are none, ZoskSync is not properly installed. Follow the
instructions for ZoskSync Installation.

• You must create a QuickBooks export file containing the data to be transferred. To do this:
• For HourzPro, create a timer export file using the "Export Lists for Timer" menu item

(available from "File->Timer Activities"). The timer export file must be named
"HrzLists.IIF" and you must save it in the Import File Path (specified in ZoskSetup.exe).

• For ExpenzPro, create an export file containing "Chart of Accounts", "Customer List", and
"Vendor List" items. All other items will be ignored by ZoskSync. The export file must be
named "ExpLists.IIF" and you must save it in the Import File Path (specified in
ZoskSetup.exe).

• Your Import File Path must exist. ZoskSync will not create it for you. ZoskSetup.exe will
create it if you tell it to, but if you change the name, move it or change access privileges of the
folder, your data will not be transferred to your PalmPilot.
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ZoskSync Doesn't Transfer Reports to My Desktop Computer
• Make sure ZoskSync is running during HotSync. To do this, open your HotSync log and look

for ZoskSync status messages. If there are none, ZoskSync is not properly installed. Follow the
instructions or ZoskSync Installation.

• Once a report is transferred, it will not be transferred again. The "synced" status of a report can
be seen in Reportz List View. If the left most column contains a "checkmark" icon, the report
is "synched". You can force a report to be transferred again using the "Transfer on Next
HotSync" menu item (available from the "Options" menu on the report detail screen).

• A report can be marked synched even if ZoskSync did not transfer the report. This happens
because the System Conduit backs up all databases and marks the records "synched".

• If you did not specify a Report Output Path (using ZoskSetup.exe), your reports will be saved
to your pilot user directory (usually C:\pilot\<user>\backup). Look there for  your reports.

• If you did specify a Report Output Path, the folder must actually exist. ZoskSetup.exe will
create this folder at setup time if you tell it to. However, if the  folder is moved, renamed, or
you change the access privileges, reports will not  be saved.

• If you do not have Windows Explorer setup to "Show All Files" or to hide extension names,
your report files may not be visible.

Expenses imported to QuickBooks aren't assigned to their project
While QuickBooks does support the attachment of a customer or job to an expense, this feature is
not available when importing from IIF files. After importing your expenses, you should assign the
customer to the job.

An account named "None" was created when I imported expenses.
ExpenzPro allows you to assign no project to your expense records. If you include these unassigned
expenses in a QuickBooks expense report, QuickBooks will automatically create an account.

Importing reports into QuickBooks Pro results in Error Messages.
Usually, this means that you haven't assigned a task to some of your HourzPro time entries.

When using QuickBooks Pro data, HourzPro uses the task field for the QuickBooks service item.
QuickBooks Pro requires a service item for each time activity. QuickBooks Pro gives you a chance
to manually correct the errors.

To avoid this problem in the future, either assign a task to all your time entries, or set the Reportz
preference to replace all tasks with a service item of your choice.
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Appendix B:
Creating ZoskSync Import Files

ZoskSync 2.3 will import lists from a text file into HourzPro, ExpenzPro and Reportz. ZoskSync
imports records into the following lists:

• Projects (shared by HourzPro and ExpenzPro)
• Tasks (HourzPro and Reportz)
• Accounts (ExpenzPro)
• Trips (ExpenzPro)
• Payees (ExpenzPro)
• Expense Types (ExpenzPro)
• Employees (Reportz)

A sample import file is included with the your software distribution (Zlists.IIF).

The Import Text File
ZoskSync looks for a file named "ZLists.txt" located in your "Import Folder Path" (specified in
ZoskSetup.exe). Use ZoskSetup.exe to specify your import folder. In the text box named "Import
File path:" enter the path where your ZLists.txt file is stored.

If ZoskSync finds a valid ZLists.txt file, and the you set the "Synchronize" mode to "All PalmPilot
Records" (in ZoskSetup.exe), ZoskSync will replace all the lists on your PalmPilot with the data
contained in ZLists.txt.

Import Format Basics
The format of the import file is a relaxed version of the Intuit Interchange Format (IIF). ZoskSync
uses IIF files exported from QuickBooks Pro. This relaxed version makes it easier to create your
import files.

• Each line in an import file is either a Header or a Record. Both of these contain tab separated
fields.

• A Header line defines the fields contained in Record lines following the header.
• Header lines always start with a '!' character followed by keyword that identifies the record type

(e.g. !PROJECT, !TASK etc.).
• Record lines also start with a keyword. The keyword is the same as the Header line for that

record type without the '!' (e.g. PROJECT, TASK etc.).
• If a Record line is found without a preceding Header line, a Default Header is assumed.
• You can add blank lines and lines with unknown keywords. These will be ignored.

Here is a simple example:
!PROJECT NAME RATE
PROJECT MyProject 24.95
PROJECT DeepPocket 250.00
TASK Consulting
TASK Design

The first line is a Header Line for the project record type. It says that only the Name an Rate fields
of the project record will be include on following lines. The next two lines are Record lines for the
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project record type. They each provide the name and the rate fields defined by their prior Header.

The last two lines are Record lines for the task record type. They were not immediately preceded by
a !TASK header so ZoskSync assumes the default task header of just the Name field.

Header Lines
Header lines define the fields for following lines. Use Header lines if you want to:

• Import a subset of the fields allows for a record
• Include extra fields to be skipped by ZoskSync
• Change the field order of a record

You can omit Header lines if the Default Header is adequate for your purposes. Below are the
Default Headers for each record types:

Projects Record Type:
!PROJECT NAME CLIENTRATE WORKORDER OTHER HIDDEN
All other record types:
!TASK NAME
!ACC NAME
!TRIP NAME
!PAYEENAME
!TYPE NAME
!EMP NAME

Record Lines
Consecutive Record lines following the header must have the fields specified by the Header. If a
new Header or Record type is found, the previous header is no longer in affect.

All fields contain strings except the RATE and HIDDEN fields of the project record. The RATE
field contains a currency number (22.25, 99) without any currency symbols. The HIDDEN field
determines if the project is to be hidden in popup lists. The project is hidden if the HIDDEN field
contains a 'Y' or a 'y' (without the quotes).

Also, the project NAME field is treated special. If it contains a colon ':' it is parsed as:
client:project. In this case the CLIENT field is not used.

Examples
See the "ZLists.txt" file for an example of an import file. The easiest way to edit and view import
files is with a spreadsheet program (Excel) that accepts tab separated text files.


